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Introduction 

The Mobiaccess IDE Helper is a support application that provides a visual designer feature for creating the 
mobile application forms much faster than writing the ’Initialize Component’ function manually. Controls 
can be added by dragging from the ToolBox and dropping on the form, the same method is used to resize 
or move the controls and the properties can be set in the Properties pane. 
The generated source can be viewed or modified on the Code Editor pane, but its not recommended. 
 

Important! This application is an unofficial helper that you may use at your own risk. Before using it, you 
should create a safety copy of your solution because this application is not fully tested and may cause 
damage to your source files if an unexpected error occurs. 
 

Important! Only the default Microsoft Windows controls can be used at the moment, so after creating 
your forms, they may look different at runtime depending on the device platform. The platform specific 
controls will be added later. 
 
 
This application is still under development and may have some faults so if you encounter one or simply 
have a comment about its functionality feel free to contact the MobiAccess development team at 
support@mobiaccess.com. 
 
  

mailto:support@mobiaccess.com
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Main Menu 

In this Section we will cover the main menu functions of the application. There are several menu functions 
that can be used with a click of an icon on the menu tool strip, or with a shortcut key as well. 
 
The Main Menu strip is located on the top of the application window. 

 
In the following we’ll walk through step by step on the main menu functions. 

File Menu 
New Project - You can create a new project with the New Project menu or 
with the New Project icon on the menu toolstrip. After selecting the New 
Project menu a dialog window appears where you can select the target 
directory of your new project. To create a new project, enter a name (this 
will be the name of the project folder) and click ’Save’. 
Open Project - You can open a project with the Open Project menu or 
with the Open Project icon on the menu toolstrip. You can also open a 
recently used project from the Recent Projects menu Item. After selecting 
the Open Project menu a dialog window appears where you can browse 
to your projects .miw file. Select the .miw file and click ’Open’ to open the 
project. 

Close Solution - You can close your solution with the Close Solution menu. 
Save - You can save the currently active class with the Save menu or with the Save icon on the menu 
toolstrip. 
Save all - You can save all your classes at once with the Save All menu or with the Save All icon on the menu 
toolstrip. 
Exit - You can close the application with the Exit menu. 

Edit Menu 
Undo - You can undo your modification made on the Designer or Code 
Editor pane with the Undo menu or with the Undo icon on the menu 
toolstrip. 
Redo - You can redo the previously undone modification made on the 
Designer or Code Editor pane with the Redo menu or with the Redo icon 
on the menu toolstrip. 
Cut - You can move your selection from the Designer or Code Editor pane 
to the Clipboard with the Cut menu or with the Cut icon on the menu 
toolstrip. 
Copy - You can make a copy of your selection from the Designer or Code 
Editor pane and move it to the Clipboard with the copy menu or with the 
Copy icon on the menu toolstrip. 
Paste - You can paste the content of the Clipboard onto the Designer or 
Code Editor with the Paste menu or with the Paste icon on the menu 
toolstrip. 
Note that if you want to paste a control onto the Designer pane, you 
must select a container control (Form, Panel or TabPage) first. 
Delete - You can delete the selected Control while the Designer pane is 

active. 
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Find/Replace - Opens the Find and Replace window where you can find and replace keywords in the 
current or all classes. 
Commen/Uncomment Selection – You can insert and remove comment prefixes to the selected lines in the 
code editor 
Increase/Decrease Indent – You can insert and remove additional indents into the selected rows. 

 

View Menu 
Code – You can switch to the code editor of the current class if its 
designer is active. 
Designer – You can switch to the designer of the current class if its 
code editor is active. 
Toolbox – You can hide/show the Toolbox pane. 
Document Outline – You can hide/show the Document Outline pane. 
Solution Explorer – You can show/hide the Solution Explorer pane. 
Properties – You can show/hide the Properties pane. 
Error List – You can show/hide the Error List pane. 
Zoom In – You can increase the font size of the active code editor. 
Zoom Out – You can decrease the font size of the active code editor. 

 

 
Tools Menu 

Run - Saves all classes, builds your application and runs the virtual 
machne if the build was successful. 
Build - Saves all classes and builds your application. 
Application Properties – You can modify the Name of your application 
and check its GUID. 
Settings - You can define custom settings for some of the applications 
functions with the Settings menu or with the Settings icon on the menu 
toolstrip. The Settings windows will be explained later. 
Go To Definition – You can navigate to the implementation of the 

method if you place the cursor into the method name and press F12 or select this menu. 
 

Help Menu 
Online Documentation - You can reach the 
www.mobiaccess.com/documentation webpage with the Online 
Documentation menu or with the Help icon on the menu toolstrip. 
Contents – Opens this document. 
About - You can view the about informations of the application with 
the About menu. 

http://www.mobiaccess.com/documentation
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Solution Explorer 

In this section we’ll discuss the functions of the Solution Explorer, located int he upper right corner of the 
application window. 
After creating a New Project a form will be automatically created under the Classes node. Note that the 
designer pane will also open up automatically, ignore it for now, we’ll talk about that pane later. 
The solution of a project will always have a Classes and a Resources node. The classes, folders and forms of 
the project will be under the Classes node and the resources 
of the project will be loaded under the Resources node. You 
cannot modify the content of the project resources manually, 
but if you add an image to a control (ie. set an Image to a 
PictureBox) the file will be copied to the resources 
automatically. 
 
There are three type of nodes that can be found under the 
Classes node of the solution:  
The Folder represents an actual folder in the file system. 
The Class represents a .class file that you can modify with the 
Code Editor, but it doesn’t have a Designer pane. 
The Form also represents a .class file but it has a Designer 
pane too. You can modify it’s source with the Code Editor but 
do not modify the highlighted parts manually, because if you 
make a mistake, the layout of the form can be damaged. 
 
Note that if a Solution is open and its files or folders are modified by another application the user will be 
noticed and asked wherher he wants to reload the modified files. 
 

 
 
 
The Solution Explorer has a menu which can be accessed by 
right-clicking on a node. 
The available functions of the menu depends on the selected 
node. 
If the Classes node is Selected, than you can add a New Form, 
add a New Class or add a New Folder to your solution. 
If a folder node is selected you can perform the same 
functions and also you can delete or rename the folder. 
If a Form or a Class node is selected, than you can Rename or 
Delete the selected file. Note that you can rename a Form and 
its class file only by selecting the Form node, and not it’s class. 
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Code Editor and Designer panes 

There are two different editor panes that can be opened at the center of the screen. Every Class has a Code 
Editor pane, but only Forms have designer panes as well. 
 
You can open the Code Editor pane of a Class node by double clicking on the node, and you can open the 
Designer pane of a Form node by double clicking on the node. You can also open the Code Editor pane with 
the source of a Form by expanding the Form node and double clicking on it’s Class node. 
You can easily change between classes and their designer/code editor panes by double-clicking on its node 
or if one is already open, simply select its page on the top of the designer/code editor pane. Once you 
opened an editor pane, you can close it by double-clicking  on the page with its name at the top. 

 

The Designer and the ToolBox pane 
 
The Designer pane is used as a representation of a Form in 
the application. You can use the drag’n’drop functionality to 
put together the forms, and set most of their properties. 
 
There are some settings concerning the design editor that 
can be changed in the Settings menu, these will be explainer 
later. 

 
To create a new control, drag the 
control from the ToolBox by 
moving the mouse pointer over 
the control and holding down the 
left button, than move your 
mouse over the parent control 
and release the mouse button. 
This way the controls parent will 
be set to the control or form that 

it was dropped on.  
 
Note that if you want to change the parent of a control, you have to use the Cut 
and Paste functions like this: 

 Select the control 

 Select the Cut from the menu (or shortcut) 

 Select the new parent (Form, Panel or TabPage) 

 Select Paste from the menu (or shortcut) 
 
To move a control, move the mouse pointer over the control until a four-
direction cursor appears. Than hold down the left mouse button, move the 
control where you want it and release the button. 
To resize a control, move the mouse pointer over the controls bottom, left or 
bottom-left corner until a two-direction cursor appears. Than hold down the left 
mouse button, resize the control and release the button to update the values. 
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The Document Outline pane 
 
 
 
 
 
The Document Outline pane can be used to change the creation order 
of the controls. You can use the Up and Down arrows to change the 
order of the controls, but only under their parents. 
Note that the TabPage order cannot be modified here, you must do that 
in the Property Grids. 

 

 

 

 
The Properties pane 

The Properties pane is located at the left-bottom corner of 
the application window. This pane is used to display and 
modify the attributes of the currently selected control or the 
form.  
The ’X’ button at the left upper corner of the pane will delete 
the selected control permanently. 
The Control Selector list at the upper border of the pane can 
be used to select a control of the form. It may help you select 
a control if for some reason you cannot select the control by 
clicking on it. 
Note that not all of the property value changes are displayed 
on the designer too, for instance if you turn the visibility of 
this label to false, the label remains visible, but in the 
generated code it will be set to false. 
Some of the controls has properties that represents 
collections. (like Items of a MultiSelectList, or TabPages of a 
TabControl). These collections can be modified in the 
Properties pane as well, with an appropriate collection editor 
window. 
 
The Positioning part may seem confusing if you are not 
familiar with it. Please visit the online documentation for 
more information about the concepts of the control 
positioning.  

There are two important things that worth mentioning about the positioning here. 
1.: If a position value is relative than it will remain relative on moving or resizing until you set its value to be 
greater than 1 or smaller than -1. Also if a position value is absolute it will remain absolute until you set its 
value between 1 and -1. 
2.: If you change the position Type, all values will be recalculated and set as a relative value even if the 
values were absolute. 
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The Code Editor pane 
Every Class has a Code Editor pane. Here 
you can modify the source of the class files, 
but do not modify the designer generated 
codes indicated by the comments, because 
the designer creates the forms from them. 
Of course you can change the properties of 
the controls but do not make major 
modifications because it can damage the 
layout of your form. 
 
The basic text editor functions can be used 
here like Cut, Copy, Paste, Undo and Redo.  
These functions work the same way as in 
any other text editors so we’ll skip its 
explanation. 
 
You can use the [+] and [-] markers next to 
the line number to collapse and expand the 
code blocks. 
 
There are two combo boxes at the top of 
the code editor. The left one is used to 
contain the member fields of the class, and 
the right one contains the methods. If you 

select a method or field from the list the cursor will move to the implementation if its a method and to the 
declaration if its a field. 
The method list also indicates that in which method block the cursor is. 
 

Error List pane 

 
The error list pane is used to display the detected faults in the source code. You can double-click on an 
error to move the cursot to its location where a red rectangle indicates the line where the error is detected 
in the code editor. 
You can enlarge the Error List pane by moving the mouse pointer over it. 
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Settings 

The Settings window is accessible through the Tools menu or with the Settings shortcut icon on the right 
side of the menu toolstrip. 

 

 
 

Screen settings 
With the Form width and Form height parameters you can set the screen size of the forms in the designer 
panes. Note that this will not affect the actual form size of your application, that will always remain the size 
of the device screen. 
 

Important! If you change the size of your forms here and the ’Keep relative positions on resize’ checkbox 
is checked than all your controls will change their size to keep the aspect ratio. 
 
As mentioned above the Keep relative positions on resize property is used to keep the relative positions on 
resize. This affects the Panel and TabPage size changes as well. 
Example: Your forms width is 320 pixels and you set a buttons width to 0.5 which means it will be 160 
pixels wide. After this if the Keep relative positions on resize is checked and you set the forms width to 640 
pixels the buttons width stays 0.5 but it will be 320 pixels wide. 
 
With the Create controls with relative positions by default property you can set whether you want your 
controls position set as absolute or as relative positions on creation by default. 

 
The Snap controls to grid boundaries property can be used to turn on and off the snap function. Snap 
means that if you move your control close to a grid line, the control will be pulled at the grids position 
automatically. This function may help you to create a well-structured form with rounded position values 
without touching the positions in the property grid at all. 
With the Snap Sensitivity property you can set the value in pixels from where a control will be pulled to a 
gridline automatically. 
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The Grid Style and Grid Density properties are used to set the display and the density of the designer forms 
grid. There are three available grid styles at the moment: 
None – The grid is not displayed, but the snap function still works if its turned on. 
Web – The grid is drawn with lines. 
Dots – The grid is drawn with dots. The snap function still applies to the invisible lines that connect the 
dots. 
The Grid Density value means that how many lines/dots will be displayed vertically and horizontally. (ie. 10 
means 10 vertical and 10 horizontal lines will be drawn with equal distances from each other. 
Note that this grid is only a helper for positioning and will not be compiled into your application. 

 

Misc Settings 
Copy Images to Resources folder – As mentioned at the Solution Explorer chapter you cannot modify the 
content of the resources folder manually, but if this property is checked and you set an image to a control 
than that image will be copied to the Resources folder automatically. 
Accessibility by default – When creating a new control, its default access modifier will be set to the 
selected. 
Member fields by default – When creating a new control, you can decide whether the controls will be 
created as member fields by default. 
Code editor type – You can decide whether you want to use the code editor with a colored or a plain text 
editor. The plain text may be faster if the source code gets bigger. 

  

Controls 
Here you will be able to choose which platforms controls you want to use on the design editor pane.  
 

Important! Only the default Microsoft Windows controls can be used at the moment, so after creating 
your forms, thay may look different at runtime depending on the device platform. The platform specific 
controls will be added later. 

 


